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1 OF 13 (1-3 INTRODUCING DATABASES)

In today's work environment, being able to find information rapidly and organize it meaningfully is increasingly important.  Computer-based databases have become one of the most widely used tools for managing information.  A database is an organized store of information constructed around a particular theme.  For instance, a business might use a database to store information about sales and stock inventories.  And a doctor might search a database to find information about particular medical symptoms.  How you organize information in a database depends on how you intend to use it.  So a doctor might use one kind of database to find information about patients' symptoms.  And the doctor's receptionist might use a different kind to store personal details and financial records of patients.  In addition to making it easier to retrieve information, databases can serve as a tool for analyzing information.  You can use a database to find patterns and trends in large volumes of data that are otherwise hard to detect.  In businesses and scientific research this is often a key function of databases.
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Databases are usually structured according to one of the following models:

• the hierarchical model

• the network model

• the relational model

The hierarchical model is organized in terms of parent-child relationships.  The hierarchical model is also known as the tree model because it follows an inverted tree-like structure.  This means that you can access several child records from a single parent record.  And child records can be grouped according to parent records.  The network model simply extends the hierarchical model by allowing more flexible linkages between parent and child objects.  For instance, a child record may have more than one parent record.  The network and hierarchical models are suitable for information that is organized in a predetermined and fixed structure.  These models are used in products such as CD-ROM-based encyclopaedias.  And the training course you are using now is organized in terms of a hierarchical model.  The relational database model is used when data needs to be organized in a flexible manner.  Records in a relational database can be grouped in many different ways according to your needs.  In a relational database you can construct queries that retrieve data that is grouped in meaningful ways.  For instance, you might use a database that has information about turnover and geographical location.  By constructing a query, you can extract turnover statistics for a particular geographical location from the database.
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In a relational database, data is described using two-dimensional tables.  Tables consist of

• columns 

• rows

Columns are used to list the various attributes of data.  So in a table that contains information about customers, you might have columns for

• names

• telephone numbers

• postal addresses

Each customer that is entered into the Customers table is a record.  Rows are generated whenever a record is captured into a table.  Each row consists of fields that correspond to the different columns.  So one might refer to the Names field in the Customers table.  A flat-file database consists of a single table.  For instance, you can think of a Microsoft Excel spreadsheet as a flat-file database.  A relational database consists of several tables.  Tables in a relational database are related to each other by shared columns.  So the Names column in the Customers table might also be a column in the Sales table.  This allows you to construct queries that link records in the Customers table to records in the Sales table.  Relational databases can be constructed and maintained using a relational database management system (RDBMS).
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Microsoft Access provides an extremely flexible environment within which to design databases, allowing you to change your basic design over time.  Even so, carefully planning your database from the start can save you time and expense in the long run.  It helps to have a clear idea of what tasks you want your database to perform.  You might create a list of the main functions you want your database to fulfill.   If other people are going to be using your database, you should ask them what sort of information they would like to get from the database.  As you gather information about the functions of the database you are designing, you may well discover that some tasks are dependent on others.  For instance, obtaining up-to-date figures on profit margins in a company is likely to depend on information about turnover and operational costs being entered accurately.  Creating flow diagrams that describe the relationships between the different elements in your database helps you in the design process.  As part of the initial planning process, you need to identify the data elements out of which your database will be constructed.  You need to define what data is needed for each task that your database performs - this is called input data.  And you need to ensure that the information generated by a task - known as output data - is what you expect.   A data element may be output data in one context and then used as input data elsewhere in your database.  You can then begin to develop the specifics of your database design by planning which tables you are going to use.  Each table should contain information about one subject rather than several subjects.  Information should not be duplicated within a table.  And information should not be duplicated across tables unnecessarily.  While planning your tables, you need to decide on the fields you will use in each table.  Fields should break down information into its smallest logical parts.  So instead of having a single field for addresses, you might have a field for postal codes, another for street addresses, and a third field for telephone numbers.  It's not usually a good idea to include data that has already been processed in your table.  So you should try to avoid creating columns that contain totals derived from existing fields.  It's more efficient to build derived data into your database when you create reports.  Fields should be as directly related to the table's subject as possible.  So sales-related information should be included in a Sales table rather than an Employees table.  It's a good idea to include an ID field for a table containing a discrete number for each record.  For example, each employee's record in an Employees table would have its own Employee ID.  ID fields are useful when you create relationships between tables.
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Once you have decided on the tables that you need in your database, you need to define relationships between the tables.  Otherwise you have little more than a collection of spreadsheets, rather than a relational database.  Relationships between tables allow you to run complex queries against multiple tables in a database, providing you with greater insight into the data in your database.  For instance, a database might have a Customers table, a Sales Region table, and a Sales table.  And you would be able to construct a single query to obtain a list of customers in a specified region that would include details of the sales made to each customer.  In order to create relationships between tables, you must define a primary key for each of your tables.  A primary key is a field or set of fields that contains different data for each record in your table.  ID fields consisting of discrete numbers automatically assigned to each record are often used as primary keys.  Let's say that in a Customers table you have defined the Customers ID field as the primary key.  And let's say that the Customers ID field is also a field in a table called Sales.  The Customer ID field in the Sales table is called the foreign key and you can create relationships between the fields in the Sales and Customers tables by using the primary and foreign keys.
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Microsoft Access allows you to link tables using the following types of relationship:

• one-to-one

• one-to-many

• many-to-many

• many-to-one

A one-to-one relationship allows you to link each record in one table to a single record in another table.  One-to-one relationships can be used to break up tables that have a large number of fields.  Although one-to-one relationships are the simplest kind of relationship, they are not that common because it's usually easier to use a single table.  In order to create a one-to-one relationship between two tables, you must use fields that are primary keys to link the tables.  A one-to-many relationship allows you to link each record in one table to several records in another table.  For instance, each employee entered into the Employees table might be linked to a large number of records in the Sales table.  But each sale that generates a record in the Sales table is linked only to a single record in the Employees table.  In a one-to-many relationship, only one of the fields being linked can be a primary key.  The primary key must be located in the table that contains one record for the many records in the other table.  So in the case of the Employees and Sales table, the Employees table holds the primary key.  One-to-many relationships are the most common relationship in databases.  One-to-many relationships are reflective - they can also be seen as many-to-one relationships if viewed from the table containing the foreign key.  Many-to-one relationships are useful when updating multiple records that are linked to a single value in another table - such as Employees from a particular region.  A many-to-many relationship between two tables allows you to create one-to-many relationships from either table.  So if you have a table for clients and a table for sports, you can link several sports to a single client.  And you can link several clients to a single sport, such as golf.  Or you can retrieve several records from the Sports table for several clients.  To create a many-to-many relationship between two tables, you need to create a third table, called a junction table.  This table will contain a primary key with at least two fields - one for each foreign key from the tables that you are relating.  One-to-many relationships are created to the junction table from the tables to join them in a many-to-many relationship.
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Let's create a diagram of tables and relationships for a database called Customer Orders that is needed by Award Sportswear.   You start by gathering information on the purpose of the database.  After interviewing a range of employees at Award Sportswear, the following information needs in relation to the Customer Orders databases are identified:

• information on each customer's   payment record

• records of which products   particular customers order

You start by deciding what tables to create, and in this case they are

• a Customers table

• an Orders table

• a Products table

• a Payment table

You now determine appropriate fields for each table, informed by your earlier research into the needs of employees at Award Sportswear.  You decide to create an ID field for each table to serve as the table's primary key.  You start by determining relationships from the central table - in this case the Orders table.  One customer can place several orders, but each order is placed by a single customer.  So you define this as a one-to-many relationship as shown.  Because some orders are paid off in installments but each installment is for a single order, you define a one-to-many relationship between the Orders table and the Payment table.  Each payment is for a particular order.

Several different products can be ordered in a single order.  And each product can be ordered many times.  So you need to create a many-to-many relationship between the Products table and the Customers table.  In order to create a many-to-many relationship between orders and products, you create a junction table called Order Details.  The primary keys of both the Orders and the Products table are included in the Order Details primary key.  You can also include fields in the junction table that are not included in the Orders and Products tables, such as Quantity.
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Microsoft Access is the Office 2000 suite's relational database management system (RDBMS).  It allows all levels of users to create their own databases with relative ease while making use of powerful database tools.  You launch Access by clicking Start and selecting the Programs menu.  Then you click the Microsoft Access option.  Access opens with the dialog box shown here.  The default setting is for an existing database to be opened.  You can choose from a list of databases recently opened or you can select the More Files option to browse to a database of your choice.  You can specify that you want to create a database rather than opening an existing database.  You can choose to create a database to your own specifications by creating a blank database and then populating it with database objects.  Or you can use a wizard to use one of the database templates to quickly create a database.  Opening Access launches the Office Assistant.  If you have hidden the Assistant while using another Office application, it will not be displayed - any settings for the assistant that you apply in an Office application are automatically applied to the other Office applications.  You can use the Office Assistant to

• display tips on using features and   shortcuts in Access

• provide you with context-sensitive  links to help files

• access help files in response to   your requests

You can remove the Office Assistant by right-clicking it and selecting Hide.  Or if you want to change its settings, you can click Options.  In the Office Assistant dialog box you can change various settings for the Assistant.
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Let's say that you decide to open an existing database.  On the left side of the Access window you find the Objects toolbar.  You can use the Objects toolbar to access the different objects that make up a database.  For example, when the Queries icon in the Object toolbar is selected, you can view a list of queries in the database window.  In the right panel you can also find tools such as wizards for creating new tables.  Tables store information about particular subjects.  Queries allow you to retrieve the information stored in tables in a variety of ways.  Forms can be used to capture information into tables.  And reports based on queries allow you to view and print information from tables.  The Pages icon can be used to view data access pages, which are used to make databases accessible from the Internet.  Macros are used to automate common tasks involving one or more actions, such as printing a report.  Modules are constructed using Visual Basic for Applications and provide added functionality to databases.  The Groups toolbar allows you to group objects of different types in a database.  This can be convenient if you tend to use different sorts of object together.
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The File menu lets you create a new database or open an existing database.  Or you can use the buttons on the toolbar.  You can use the Edit menu to work with database objects.  And there are toolbar buttons corresponding to functions on the Edit menu.  Instead of selecting database objects to view with the Objects toolbar, you can use the Database Objects options on the View menu.  And you can change how information is displayed in the Database window.  For instance, if you want to view object details, you select the Details option.  You can customize your toolbars by choosing Customize from the Toolbars option on the View menu.  In the Customize dialog box there are a range of toolbars that can be enabled by selecting their checkboxes.  In the Database window toolbar you find buttons for the functions on the View menu.  You also find a context-sensitive button for creating new objects.  And there is a button for deleting objects selected in the database window.  You can use the Open object buttons on the Database window toolbar to open database objects such as tables.  The Open datasheet button opens the tables or query selected in the Database window in Datasheet view.  You can use Datasheet view to view records in tables and queries and to create new records in tables.  The Design button opens database objects in Design view.  You can use Design view to modify the properties and appearance of database objects.
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Microsoft Access 2000 provides you with templates for creating different sorts of database.  The Database Wizard uses your chosen template to create a ready-to-use database.  Let's say that you want to use Access to create a database of customers and their orders for Award Sportswear.  You begin by selecting Microsoft Access from the Programs options on the Start menu.  Microsoft Access launches with an opening dialog box.  To hide the Office Assistant, you right-click it and select Hide from the shortcut menu.  You select the Access database … projects radio button and you click OK.  You now choose from a range of wizards that can be used to create different types of database.  You select the Order Entry wizard and click OK.  In the File New Database dialog box screen you type a filename you choose for the database.  And you click Create to launch the wizard for creating an Order Entry database.  The opening screen of the Database Wizard provides you with information about the tables in the database that you are creating - you click Next.  The Database Wizard launches a dialog box that provides a list of tables in your database.  And when you select a table from the list, you can view a list of fields in the table.  The fields in italics are optional fields and by default are not selected.  Let's say that you want to include e-mail addresses as a field in the Customer Information table.  You do this by selecting the Email Address checkbox.  To view the fields in the Order Details table, you simply select the table from the list.  Once you have finalized the fields in your database, you click Next.  The Database Wizard allows you to customize the appearance of displays in your database - in this case you select Stone and you click Next.  You can choose a style for printed reports - in this example, you select Compact and you click Next.  You can choose a title for your database - in this case you type Customer Orders.  And then you select the checkbox to include a picture in printed database reports and you click the Picture button.  You then browse to the folder containing the picture you want, select the picture, and click OK.  The picture is displayed by the wizard - and you click Next to continue.  In the final dialog box of the Database Wizard the default setting is for your database to start when you finish the wizard.  To display help, you select the Display Help … database checkbox and click Finish to create and start the database with the settings you have chosen.  Once the database has been created, the message box shown here appears, and you click OK in order to provide your company details.  You then type your company's details into the text boxes as shown here.  The Database Wizard creates your database using the specifications you have supplied.
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When you use the Database Wizard to create a database, the wizard automatically creates a switchboard for your database.  A switchboard is a form containing controls such as buttons that you can use to navigate a database.  You decide to start entering data into your database by capturing information about products.  So you click the Enter/View Other Information button.  You then click the Enter/View Products button to capture information about products.  In the form that launches, you start by typing in the product's name - the Product ID is automatically generated.  And you type a price per unit for the product in the Unit Price field - an input mask prevents you from entering inappropriate datatypes, such as letters.  You can press the Tab key to move your cursor to the next field, or you can click the field.  After completing the product details, you click the Save button to immediately update the Customer Order database.  To create a new record, you click the New Record button.  And then you type in the details of the record.  To return to the previous record, you click the Previous Record button.  Once you've captured the records you need, you choose the Close option from the File menu to close the form.  You can then capture information for the other categories in the switchboard in the same way.  Once you're finished, you return to the main switchboard by clicking the button shown here.
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If your needs are specific, you may not want to use the database templates provided by Microsoft.  You can create your own database with Microsoft Access.   You start by creating a blank database and then you build the database objects that you need - such as tables, forms, queries, and switchboards.  Let's say that you want to create your own database without the help of a wizard.  You select File - New.  In the New dialog box you select the Database icon and click OK to create a blank database.  Then you type a filename for your database in the space provided.  And you click the Create button to create and save a blank database and launch the database in Design view.  The database opens with the Tables option selected in the Objects toolbar.  The Database window shows different options for creating tables.  You can specify the type of database object you want to create by selecting it in the Objects toolbar.  When you create a blank database, no tables are created, so you cannot capture data.  Instead, a file is created in which you can store the database objects that you need to create in order to build a functional database.

END OF PLANNING AND CREATING DATABASES

SUMMARY: You have seen how to plan and create a Microsoft Access database.  A database is a collection of information about a particular theme. There are several different models for computerized databases.  Computerized databases are usually organized according to the hierarchical, network, or relational models. Relational databases consist of two-dimensional tables of data that are related to each other in different ways.  Because of their flexibility and the complex analysis of large volumes of data they make possible, relational databases are widely used by businesses and other organizations.   The first step in planning a database is to examine why you need a database. This involves talking to the people whom you expect to use the database and finding out what their information needs are. During this phase you can create a list of the sort of data that is needed from the database, and the sort of data that will have to be captured into the database to provide the information needed.  Then you need to group your data into logical subjects to form tables.   Once you have decided which tables to use, and while you plan the columns you need, you need to define relationships between your tables. You can link one record in a table to many records in another table in a one-to-many relationship. Other possible types of relationship are one-to-one and many-to-many.  Microsoft Access 2000 is the Office 2000 suite's relational database management system (RDBMS). It can be used to build and maintain relational databases.  The main features of the Access interface are the Database window and the Database window toolbar, the Objects bar, the Access toolbars, and the menu bar.  The Objects bar groups database objects according to type. For instance, all tables are grouped together by the Object bar. You can use the Group bar to create convenient groups that contain objects of different types.  Microsoft Access 2000 provides you with templates for creating different sorts of database. The Database Wizard uses your chosen template to create a ready-to-use database.  You can navigate the database you create with the wizard by using the switchboard that it generates.  If your needs are more specific, you can create your own database. You first create a blank database and then build the database objects that you need - such as tables, forms, queries, and switchboards.

UNIT TEST:

1. Which of the following descriptions describes a database?

a. A store of information about different themes

b. A special type of application used to store information

c. An organized store of information constructed around a particular theme

d. Any information that is in binary format

2. Microsoft Access is used to create databases that conform to the _____ model.

a. network

b. hierarchical

c. tabular

d. relational

3. Data in a _____ database is organized in a more flexible structure than data in a _____ database.

a. network

b. relational

4. Which of the following statements describe columns in a database table?

a. Each record in a database is entered into a new column

b. Each field in a record corresponds to a column in the table

c. Columns are used to describe the attributes of the subject of a table

d. The number of columns in a table increases as you add new records to the table

5. If you include the Customer ID primary key from your Customer table in the Sales table, it becomes _____ key in the Sales table.

a. the primary

b. a foreign

c. a secondary

d. an outer

6. By creating _____ relationships from two tables to a junction table, you can create a _____ relationship between the two tables.

a. many-to-many

b. one-to-many

7. Which of the following statements describe how primary and foreign keys are used in one-to-many relationships?

a. The foreign key must be located in the table containing one record linked to many records in the second table

b. The primary key must be located in the table containing one record linked to many records in the second table

c. The value of the primary key field is different for each record in a table

d. The value of a foreign key field is different for each record in a table

8. Which of the following options describes the function of the Groups toolbar?

a. You use it to specify which user can access a database and with what rights

b. You use it to group database objects of different types that are frequently used in conjunction with each other

c. You use it to store queries that group records

d. You use it to group database objects according to object type

9. Which of the following are categories of database objects that can be selected on the Objects toolbar?

a. Tables

b. Macros

c. Modules

d. Queries

e. Datasheets

10. Which of the following settings can be determined using the Database Wizard?

a. The appearance of the database

b. The tables that are included in the database

c. Optional fields to be included in tables

d. The reports that can be generated from the database

ANSWERS:

1. c

2. d

3. 1st blank: relational, 2nd blank: network

4. b & c

5. b***(a)

6. 1st blank: many-to-many, 2nd blank: one-to-many***

7. b & c

8. b

9. a, b, c & d***(be)

10. a, b & c
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Microsoft Access allows you to create a table

• using the Table Wizard

• using Design view

• by entering data in   Datasheet view

The Table Wizard allows you to choose the fields for your table from a variety of sample tables.  These include business tables, such as customers and products tables, and personal tables, such as household inventory or exercise log tables.  You create a table in Design view if you want greater flexibility in defining your table's fields.  Design view allows you to specify the details of the table, such as each field's data type.  You use Datasheet view if you want to enter data directly into a blank sheet.  When you save the datasheet, Access analyzes the data and assigns the appropriate data type to each field.  In every table a primary key for which each entry is unique can be assigned.  The primary key serves as a kind of identity number that identifies and distinguishes between records.  In Access there are three kinds of primary key:

• AutoNumber

• single field

• multiple field

To create an AutoNumber primary key, your table needs a field with the data type set to AutoNumber.  Access then automatically assigns a sequential number to each record.  If your table has a field that contains unique values, such as ID numbers, you can set that field as a single-field primary key.  But Access won't set the primary key if it finds that the field contains duplicate or null values.  If your table doesn't have a field with unique values, you can opt for an AutoNumber key.  Or you can define a multiple-field primary key.  To assign a multiple-field key, you choose two or more fields, the combination of which needs to produce unique values.
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To view the different ways to create a table, you click the Tables object on the Objects bar in the Database window.  Alternatively, you select Insert - Table, which opens the New Table dialog box.  Then you double-click an option, in this case you choose the Create table by using wizard option.  The Table Wizard dialog box opens, presenting a list of sample tables and sample fields.  By clicking either the Business or Personal radio button, you can switch between different types of sample table.  When you select a table from the Sample Tables list - for example Exercise Log - the fields it contains are displayed in the Sample Fields list.  If you decide you want a certain field in your table, you first select it.  Then you click the Add button.  And the field appears in the Fields in my new table list box.  To add all the fields of a sample table to your table, you click the Add All button.  And all the sample fields appear in the Fields in my new table list box.  You can add as many sample fields from as many sample tables to your table as you like.You simply select different sample tables in turn and use the Add and Add All buttons to add fields.  If you want to change the name of a field, you select the field and click Rename Field.  When the Rename field dialog box opens, you type the new name and click OK.  To remove fields from your table, you use the Remove and Remove All buttons.  When you have specified the fields you want in your new table, you click Next to move to the next page of the wizard.  Then in the What … table text box, you type the name of your table - in this case Workouts.  The Table Wizard provides a choice between letting you set a primary key or setting it for you.  To let the Table Wizard set the primary key for you, you accept the default setting and you click Next.  If you want to set the primary key yourself, you select the No, I'll set the primary key radio button and you click Next.  You select the field you want as the primary key from the What … record drop-down list - in this case PersonID.  Then you specify its data type - in this case you select Numbers I enter … records.  And you click Next.  You specify what you want to do after the wizard creates the table.  You can choose to modify the table design, enter data directly into the table, or enter data into the table using a form the table creates.  In this case you accept the default setting to enter data directly into the table and you click Finish.  The Table Wizard creates a table with the fields you selected and the primary key - in this case PersonID - you assigned.

3 OF 12

You create a table in Design view if you want to specify a table's details yourself - for example, if you want to specify a data type not available in the Table Wizard.  And regardless of the method used to create a table, Design view is where you do subsequent modifications to table design.  In Design view you specify all field names, data types, and field properties.  To create a table in Design view, you double-click Create table in Design view in the Database window.  Alternatively, you click the New button and select Design View in the New Table dialog box.  Access then opens Design view.  It consists of a blank sheet with Field Name, Data Type, and Description columns and a Field Properties section.  In the Field Name column you type a name for the field - in this case EmployeeID.  A field name may be up to 64 characters long, spaces included.  You then press the Tab key to move to the Data Type column to specify the kind of value the field will contain.  You select a data type - for example AutoNumber - from the drop-down list that appears when you click the down-pointing arrow.  If you want to provide a description for the field, you press the Tab key and type it in the Description column.  Field descriptions are optional.When provided, they appear in the status bar of the related form.  The data type determines the field properties displayed on the General tabbed page in the Field Properties section.  You can alter them or specify additional properties - for example, a caption for the field.  To set up an index for this field, you select the Indexed property box.  Then you select Yes (No Duplicates) to ensure that no two records have the same data in this field.  The Lookup tabbed page in the Field Properties section allows you to define or modify a field that looks up its values from another table.  When a field is not a Lookup field, you'll see that the Lookup tabbed page displays a default text setting or is grayed out for certain data types - such as Memo.  After you've specified all your table's fields and set the data types, you select the field you want to designate as the primary key.  And you click the Primary Key button on the Table Design toolbar.  Alternatively, you select Edit - Primary Key.  A key symbol appears next to the field name to show that the field is the primary key.  To view the table you've created, you open it in Datasheet view by clicking the View button on the Table Design toolbar.  Access asks if you want to save the table and you click Yes.  When the Save As dialog box opens, you type the name of the table.  And you click OK.  Access then displays your table in Datasheet view.
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You use Datasheet view if you want to create a table by entering data into a blank sheet.  Irrespective of the method used to create a table, Datasheet view is where you add, delete, or modify data.  To create a table in Datasheet view, you double-click Create table by entering data in the Database window.  Access then opens a blank datasheet with default field names - Field1, Field2, and so on.  To rename a field, you select the Format menu.  Then you select Rename Column.  You type the new field name and you press Enter.  The new field name now appears at the head of the column.  Access will delete unused columns once you save the table.  You enter data by typing each value in a separate cell.  Each field receives entries only of a single data type.  To insert a new column, you click the column to the right of where you want to insert the column.  And you select Insert - Column.  The new column now appears in the table.  Access assigns data types and creates a primary key when you save your table.  To save the table, you click the Save button on the Table Datasheet toolbar.  In the Save As dialog box you type the table name and you click OK.  A dialog box opens asking if you want to create a primary key and you click Yes.  Datasheet view now displays your table with an additional column called ID, which contains sequential numbers.  To view the way Access analyzed your data, you switch to Design view by clicking the View button.  Access lists the field names on the left.  And it lists the data types it assigned to each field in the Data Type column.  A key symbol appears next to the ID field created by Access, indicating that this is the primary key.
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Let's say you want to create a table called AwardProducts for the products of your company, Award Sportswear Inc.  You'd like the table to have fields for the products' ID numbers, names, and prices.  As the Table Wizard has a sample table that meets your needs, you decide to use it.  So you double-click Create table by using wizard in the Database window.  The Table Wizard dialog box opens.  To view sample fields you may want to use, you select Products from the Sample Tables list.  And its fields are displayed in the Sample Fields list box.  The ProductID field is selected by default.  So you click the Add button to include the field in your table.  The ProductID field now appears in the Fields in my new table list box.  You repeat the process for the remaining fields you want to include in your table.  Then you click Next to continue creating the table.  You type the name for the table - AwardProducts - in the What … table text box.  To allow the Table Wizard to set the primary key for you, you choose to accept the default setting - Yes, set a primary key for me.  And you click Next.  The Table Wizard asks you what you want to do after the table is created and you accept the default setting to enter data directly into the table.  Then to create the table, you click Finish.  The table opens in Datasheet view, ready for you to enter data.

6 OF 12 (6-8 MODIFYING A TABLE)

You modify table design in Design view.  You can add, delete, or modify a table's

• structure

• data types

• field properties

Suppose you want to change the structure of your table by changing the order of the fields.  To do this, you first select the fields you want to move by clicking and dragging through their row selectors.  Then you drag the fields through the row selectors to their new location.  The field order now reflects the move.  And the column order in Datasheet view has changed accordingly.  To insert a new field between the other fields, you click the row above which you want to add the new field.  Then you click the Insert Rows button on the Table Design toolbar.  Access inserts a blank row and you can now define the new field.  To remove a field, you click its row.  And you click the Delete Rows button on the Table Design toolbar.  You can also select the whole field and select Edit - Delete.  Access asks you to confirm that you want to delete the field with all its data and you click Yes.  The field and its data are now removed from your table both in Design view and in Datasheet view.  To change a field name in Design view, you double-click it.  And you type the new field name.  To reflect a field name change in Datasheet view, no caption should be specified in the Field Properties section in Design view.  To change the primary key, you click the row of the field you want to designate as the new key.  Then you click the Primary Key button.  The key symbol now appears next to the new primary key field.
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Design view offers a number of options for defining a field's data type and properties.  A field's data type determines which and how many characters may be entered in that field.  Some of the data types available in Access are shown.  Text - which includes text and combinations of text and numbers, such as addresses - is the default data type and can be up to 255 characters long.  If you want to be able to enter large amounts of text and numbers, you'll need to set the data type to Memo in order for Access to accept it.  The Memo data type permits up to 65,535 characters per field.  You select Number as the data type if you need to enter numerical values that will be used in calculations but that do not involve money.  For calculations involving money, you need to use the Currency data type, which will not round off the values.  The Date/Time data type is suitable for entering dates and times in certain formats.  And by means of the AutoNumber data type, you can instruct Access to provide a unique number - sequential or random - for each new record.  The Yes/No data type allows only one of two values to be entered, for example Yes or No, On or Off, True or False.  You use the OLE Object data type for objects such as Microsoft Word documents or graphics that are linked to or embedded in an Access table.  When the data type is set to Hyperlink, Access will accept text or combinations of text and numbers used as hyperlink addresses.  If you want to create a field that looks up its data in another table or query, you select Lookup Wizard to open a wizard that will help you define the field.  To specify or change a field's data type, you click in the Data Type column next to the field name.  A down-pointing arrow automatically appears and you click it to view the options.  To change the data type, you select the option you want - in this case Text.  Text now appears in the Data Type column next to the field name.  This means that your table field will accept data in text form - short text or combinations of text and numbers.  A field's data type largely determines its field properties.  Field property settings - for example Field Size - are defined in the Field Properties section.  To specify or modify a field property, you click its text box.  You can also press F6 to switch between the data definition section and the Field Properties section.  You then type the setting you require or you select it from a drop-down list.  Let's say you need to specify that a certain field may never be left blank.  To do this, you first click its field row to open its Field Properties.  To require that data is always entered in the field, you click the text box next to Required on the General tabbed page in Field Properties.  Then you choose Yes from the drop-down list.  Access will now refuse to accept a record if no data is entered in this field.
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Let's say you need to modify your AwardProducts table by moving the second field to before the first field.  You want to insert a new field called "UnitsInStock" before the last field.  And you want to specify Number as its data type and General Number as its format property.  To move the second field, you select it by clicking the row selector.  Then you drag the field to its new location.  To insert a new field above the last field, you click the last field row.  And you click the Insert Rows button to insert a new row.  You type the field name for the new row in the Field Name column.  Next you press Tab to move to the Data Type column.  And you click the down-pointing arrow to view the list of data types.  To specify a numeric data type, you select Number.  The new field will now accept only numeric data.  To specify a predefined format for the data type, you click the Format text box in the Field Properties section.  Then you click the down-pointing arrow to view the list of format options.  And you select General Number from the drop-down list to display numbers in the General Number format.  When you have finished modifying your table, you save the changes by clicking the Save button.

9 OF 12 (9-12 LOOKUP AND INPUT MASK WIZARDS)

In Access the Lookup Wizard allows you to create a

• Lookup list field

• value list field

A Lookup or value list field enables you to display a list of values in a field in Datasheet view.  You then select a value from the list for each cell in the field.  You create a Lookup field if you want a field to look up its values from an existing table or query.  You can also create a Lookup field that looks up its values from another field in its own table.  You create a value list field if you want the field to display a fixed set of values that you specify.  You can create a Lookup field or value list field in Design view or in Datasheet view.  To create a Lookup field in Design view, you click the Data Type cell of the field that needs to display the Lookup list.  And you select Lookup Wizard from the drop-down list.  The Lookup Wizard dialog box opens and to create a Lookup field rather than entering the values yourself, you accept the default I … query setting.  Then you click Next to proceed.  On the next page of the wizard you select the table from which you want the values to be taken.  And you click Next.  To specify the field from which to take the values, you first select it in the Available Fields list box.  And you click the Add button.  The field now appears in the Selected Fields list box and you click Next.  On the next page of the wizard you can drag the right edge of the column to the width you want or double-click the right edge of the column heading to get the best fit.  In this case you double-click the right edge of the column heading and you click Next.  In the What label … column text box you type a label for the Lookup column.  Then, to create the Lookup field, you click Finish.  The name of the foreign key - in this case the same as the original field name, EmployeeID - appears in the Field Name column.  The foreign key is the primary key of the table from which the values come.  And Access has set the appropriate data type.  To view the field properties of the Lookup field as defined by Access, you click the Lookup tab.  You can then modify the properties by, for example, setting the Column Heads property to Yes so that the Lookup columns will display headings.  To view the Lookup list, you switch to Datasheet view.  You then click the down-pointing arrow in the cell of the Lookup field to display the looked up values you can select.  You can create a Lookup field in Datasheet view by selecting Insert - Lookup Column.  You then use the Lookup Wizard as you would in Design view.
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Suppose you need to modify a Lookup or value list field that you created.  For instance, you want to change a field that looks up its values from a table into a field displaying a fixed set of values that you provide.  This requires changing a Lookup list field to a value list field.  To modify a Lookup (or value list) field in a table, you first open the table in Design view.  Then you click the Data Type cell of the Lookup field - in this case EmployeeID.  And you click the down-pointing arrow to view the drop-down list.  You select the Lookup Wizard option to launch the wizard that allows you to modify the Lookup field.  On the first page of the wizard you specify the kind of field into which you want the Lookup field to change.  You can also choose to keep the field a Lookup field and then change the table or field from which the Lookup field gets its values.This can be done by means of the wizard or by opening the Query Builder when you are in the Row Source text box of the Lookup tabbed page.  As you want the field to become a value list field, you select the I will type in the values that I want radio button and you click Next.  The next page of the Lookup Wizard opens, allowing you to specify the number of columns and the values you want.  In the Number of columns text box you type 2 to specify two columns for your value list.  You click the cell in the first column and type the first value - which causes the next row to appear.  You then press the Tab key to move to the second column and type the second value that needs to go with the first.  After you've added all the values you want, you click Next.  On the next page of the wizard, you choose a column in the Available Fields list that contains values you'd like to store in the database for later use.  And you click Next.  On the final page of the wizard you type a label for the lookup column - in this case Employee - in the What label … column text box.  And you click Finish to create the new Lookup field.  On the Lookup tabbed page of the Field Properties section you can see how the field's properties have been modified to reflect changes you made to the field.  You change the Column Heads property to No so that no heading row will be displayed.  You save the table by clicking the Save button.  To view the changes to the Lookup field, you switch to Datasheet view by clicking the View button.  The drop-down list in the Lookup field in Datasheet view now displays the columns with the values you have specified.  To specify a value for a cell in the Lookup field, you select a row - in this case the second row - of the value list.  The cell always displays only the value of the first column of the row you select.
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Access allows you to define an input mask for a field using the Input Mask Wizard.  The input mask controls the exact format in which the field's values - for example social security numbers - are entered.  Input masks are also known as field templates.  To define an input mask for a field, you open a table in Design view.  By clicking in the field's row, you display its properties in the Field Properties section.  On the General tabbed page you click the Input Mask property text box.  And you click the Build button to open the Input Mask Wizard.  The Input Mask Wizard opens, presenting you with a number of input masks to choose from.  It also displays an example of the format each input mask enforces.  You select the input mask that matches how you want your data to look from the Input Mask list - in this case Phone Number.  To see how an input mask works, you click the Try It text box to display the empty mask.  It accepts characters you enter only if they agree with the predefined format.  When you have selected your input mask, you click Next.  The Input Mask Wizard asks if you want to change the input mask and its placeholder character.  To change the placeholder, you click the Placeholder character down-pointing arrow.  And you select the character of your choice.  By clicking the Try It text box, you view its display format and you click Next.  On the final page of the Input Mask Wizard you can choose to store the data with or without the symbols.  In this case you select the With … this radio button.  And you click Finish to create the input mask.  The formal definition of the input mask now appears in the Input Mask property text box.  You can enter an input mask definition manually without using the Input Mask Wizard.  If you change the formal definition in the Input Mask property text box, it will change the input mask itself.  You can view or use the input mask by switching to Datasheet view and clicking the field for which you specified the mask.
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You may want to change an existing input mask.  You can edit the format of the input mask if you need to customize the data entry format.  Input masks work only in text or date fields.  Suppose you want to type a new description for the Phone Number input mask and specify a three-digit extension.  To edit the input mask, you open the Input Mask Wizard by clicking the Build button, which becomes available when you click the Input Mask property box.  On the Input Mask Wizard you click the Edit List button.  You can select the input mask you want to change by clicking the Record navigation arrows - in this case you accept the first input mask, Phone Number.  In the Description dialog box you type a new description for the input mask - in this case Phone Number and Extension.  Since the Award Sportswear branches use a three-digit extension, you type /000 in the Input Mask text box.  And in the Sample Data dialog box you type /312.  You click Close in the Customize Input Mask Wizard dialog box.  Then you click Finish on the Input Mask Wizard.  And the changes are reflected in the input mask text box.

END OF WORKING WITH TABLES

SUMMARY: You have seen how to create and modify tables. In Microsoft Access there are different ways to create a table.  The Table Wizard allows the user to create a table by choosing from the sample tables and sample fields it provides. Design view is used when the user wants to create a table by defining special fields not offered by the wizard. In Datasheet view a table can be created by entering data into a blank datasheet. Access then analyzes it and assigns data types.  Regardless of its method of creation, every table requires a primary key - a field for which all values will be unique with respect to each other. The primary key provides a means of identifying and distinguishing records. It can be assigned by the user or the user can allow Access to assign it.  In Design view the user can modify a table's structure. The order and number of fields can be changed by moving, inserting, or deleting fields.  Access allows the use of multiple data types. This means that the user can specify an appropriate data type for each field by choosing from a number of options in Design view.  A field's data type correlates with a specific set of field properties. These are displayed in Design view and can be modified by the user to fulfill particular requirements.  By means of the Lookup Wizard in Design view, Access allows the user to create a Lookup list field or a value list field. Whereas a Lookup field looks up its values from an existing table or query, the fixed set of values of a value list field is entered by the user when creating the field.  The Lookup Wizard can also be used to modify an existing Lookup or value list field by specifying new properties for it.  In Access it is possible to control the format in which data is entered. This is done by using the Input Mask Wizard in Design view. By choosing a certain input mask for a field, the user ensures that only values entered in the correct format are accepted by Access.

UNIT TEST:

1. Which of the following can you do in Design view?

a. Create a Lookup field

b. Enter data in fields

c. Specify a field's data type

d. Use sampel tables to create a table

e. Specify field properties

2. You need to create _____ primary key if none of your table's fields consists of unique values.

a. a single-field

b. An AutoNumber

c. a multiple-field

3. Which of the following can you do in Datasheet view?

a. Create a table

b. Enter, delete, and modify data

c. Change the primary key

d. Create new fields

e. Change field names

4. Which of the following happens in the Datasheet view if you delete a field in Design view?

a. The field is deleted but its data is preserved

b. The field remains but its data is deleted

c. The field and its data are preserved

d. The field and its data are deleted

e. The field and its data become hidden

5. Can you modify a field's properties once its data type has been set?

a. Yes

b. No

6. In which of the following can a Lookup field look up its values?

a. A query

b. A report

c. A Word document

d. The Internet

e. A table

7. How do you modify a Lookup or value list field?

a. By using the Lookup Wizard to specify new properties for the field

b. By entering new values in the Lookup or value list columns in Datasheet view

c. By deleting the field and recreating it

8. It is by means of _____ field that you control the format in which new values are entered in a table.

a. a value list

b. a Lookup list

c. an Input Mask

9. You can delete the formal definition in the Input Mask property text box without affecting the input mask itself.

a. True

b. False

ANSWERS:

1. a, c & e***(d)

2. c***(b)

3. a, b, d & e***(de)

4. d***(a)

5. Yes

6. a & e***(b)

7. a

8. c

9. False 

BEGINNING ACCESS

WORKING WITH FORMS 

1 OF 6 (1-4 CREATING FORMS AND CONTROLS)

A form is a database object that contains controls that you use to enter, view, or edit data in fields.  You can also use controls on forms to perform particular actions.  There are benefits to creating forms, over using tables, for the purpose of editing and entering data.  Forms can be customized to suit a user's requirements for inputting data.  And they can be made more visually appealing.  Using forms removes the problem of not being able to read data entries where columns haven't been set wide enough.  And forms allow you to enter information into different tables at the same time instead of having to open tables individually.  A form generally shows only one record at a time, so it is easier to know which record you're working on than when you work with tables.   You can create a generic form using the AutoForm function in Microsoft Access.  You can create a customized form using the Form Wizard.  You can create a form from scratch in Design view.
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Let's suppose you want to use the Form Wizard to create a form that will specify special offers for limited periods on the different Award Sportswear products.  In the Database window you select Forms under Objects.  And you click the New button on the Database window toolbar.  In the New Form dialog box you select Form Wizard.  You specify the source table for your form from the Choose the table… from drop-down list.  If you do not specify a source, the first table in alphabetical order is selected by default.  And you click OK.  To select a field that you want to appear on your form list, you select it and click the Add Field button.  If you need to provide fields for a table or query other than the one displayed, you can change the data source in the Table/Queries drop-down list box. If you change the data source, the Form Wizard creates an underlying SQL query.  Or you can click the Add all Fields button to move all the listed fields across at once.  And you click Next to move to the next wizard step.  You select the layout you would like for your form and you click Next.  Then you select a style for your form and you click Next.  You provide a title for your form, decide whether to modify the form's design, and click Finish.  The newly created form is displayed in Form view.
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All the information on a form is displayed in controls.  Controls can be thought of as graphical objects that appear on a form, report, or data access page.  These objects can display data, perform actions, or be used for decoration.  Microsoft Access provides a number of different controls that are accessible through the Toolbox when you choose to work in Design view.  These controls include the text box, label, option group, option button, checkbox, list box, command button, image control, object frames, line, rectangle, and other custom controls.  And forms, like reports, have additional controls including the toggle button, combo box, bound object frame, unbound object frame, subform/subreport, and page break.  Controls can be bound, unbound, or calculated.  A bound control is associated with a field in a table or query and is used to reflect the field's values.  An unbound control does not have a data source and is used to display information and graphics, or to allow input from the user.  A calculated control derives its source data from an expression.  You can think of this expression as a formula that you create to define how data from a field in a table or report is used.  And such an expression is also able to use data from another control on the same form or report.  When you open a form from the database window, it appears in Form view, so you need to convert it to Design view to make changes such as adding controls.  The different field options in the Field List are those you specified - for the particular table or query - from the list in the Form Wizard.  And the controls that you can add to a form are found in the Toolbox.  If the Field List and the Toolbox do not appear with the form Design window, you can click their respective toggle buttons on the toolbar.Or you can select the respective items from the View menu.  To add a control that displays data from a particular field in the Field List, you drag the field on to the Detail area of the form.  In this case a text box control is added by default.  And you repeat this operation as often as required to create controls from the available field options.  You use the control Toolbox to add controls to a form.  It is much easier to do this with the help of wizards, so you first need to make sure that the Control Wizards button in the Toolbox is selected.  Then you select the control you wish to use, in this case a list box.  When you select a control, the mouse pointer changes into a small graphic representing the control that you selected.  You click the pointer where you want the control to appear in the form's Detail area.  And when you release the mouse button, the List Box Wizard is displayed.  You create a calculated control by first selecting the type of control that you want to use - in this case a text box.  You then position the text box on the form and type the required expression directly.  A text box is the most commonly used control for calculated controls, but any control with the ControlSource property can be used.  If you have not chosen a text box as your control, you need to select the control and to then access the ControlSource property box for the control by clicking the Properties button on the toolbar.  Or you can double-click the control, or right-click it and select Properties.  And following any one of these actions, you enter the expression in the property box.  You can insert an image file into the form.  To do this, you click the Image control from the Toolbox.  When you move the pointer to the form, it changes to the Image pointer.  Click the form where you want to place the image.  Access opens the default image library.  You select the image file you want and click OK.  The image is inserted into the form.
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Let's suppose you want to use a calculated control to reflect a special offer discount of 25 percent, and then to add a list box control to specify when the offer ends.  To begin creating a calculated control using a text box in Design view, you select the text box option in the Toolbox.  You click your mouse where you want the control to appear on the Detail area of the form.  When you release the mouse button, the new text box control appears, and you click the text in the label field to select it.  You label the control by selecting the text and typing Special Offer, and then you select the control field followed by its text before entering the expression:  =[UnitPrice]*0.75  You can use the Expression Builder feature to create expressions.  You now want to add a list box control to allow you to specify when the special offer ends, so you select this control option in the Toolbox.  And you click your mouse to position the list box on the Detail area of the form.  When you release the mouse button, the List Box Wizard appears, and you want to enter your own values so you select the I will …I want radio button.  The Wizard button in the Toolbox was already selected so you didn't need to enable this function by clicking the Wizard button first.  And you click Next to move to the next step in the wizard.  You need only one column in your list box, so you place the mouse pointer in the first row and type one of the date options for when the special offer will end.  This wizard step allows you to specify the number of columns in your list box, as well as letting you resize the column width.  You press Tab to enter this and additional date options - as required - before clicking Next.  You want your database to store the values you specify in the list box, so you select the Store that value in this field radio button.  And you click the down-pointing arrow to list the fields in the database.  You select SpecialOffer Ends and when this field appears selected, you click Next.  The final step of the wizard is to name the list box before clicking Finish.  You can now view the form by clicking the down-pointing arrow next to the View icon on the toolbar, and selecting Form View.  You can also select this menu item from the View menu.Or you can simply click the View button because the form icon is displayed.  And your form appears with its new controls.

5 OF 6 (5-6 MODIFYING CONTROLS AND SECTIONS)

You are able to use Design view to make a form more attractive in terms of both the layout and text format of controls.  And you are able to make use of the Form Header, Footer, and Detail sections, in order to do this.  The easiest modification that you can make to a form is to reposition one of the controls.  To do this, you click the control's name so that selection handles appear around the control.  You can select several controls at once by selecting the first one and then individually shift-clicking others, or you can drag an outline around the controls that you want to select.You then need to position the mouse pointer so that it appears as a hand to reposition a control or controls.  And you use the pointer to move the control or collection of controls.  You can resize a control by dragging one of its corners while holding down the left mouse button.  But you must first hover the mouse pointer over the corner until it appears as a double diagonal-pointing arrow.  And you let go of the mouse button at the point that leaves the control at the size you want it to be.  You can use the pointer to move controls and their labels independently of each other.  But you need to position the pointer over the control field's border so that it appears as a pointing finger in order to do this.  You can resize a control horizontally or vertically after selecting it by moving the pointer in either of these two planes.  You need to hover the pointer over one of the edges until a double-edged arrow appears.And you can drag the selection handles on the bottom line of a text box or label control downwards so that the text wraps to the next line.  When you work with a form, you can make use of the Header and Footer areas, in addition to the Detail area.  The Form Header and Form Footer areas are used to display text on screen at the top and bottom of the form respectively.  The Page Header and Page Footer areas are used in the same way to display text when the form is printed.  You can enlarge the Form Header area by selecting the Detail bar, positioning the pointer between these two bars, and dragging downwards.  And you can enlarge the Form Footer area by selecting its title bar, positioning the pointer at the bottom of the bar, and dragging downwards.  In both these cases the pointer must appear as an upright double-edged arrow with a horizontal line through it.  To view the Page Header and Page Footer areas, you need to select Page Header/Footer from the View menu.  You add text to the different sections of the form by selecting the Label button in the Toolbox.  And you click the position where you want to add the label so that a small box appears.  You must now type the text before clicking the mouse pointer anywhere else, otherwise the small box disappears.
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Once you have laid out the controls on your form, you can apply various formatting options

• from the formatting toolbar

• using AutoFormat

The formatting toolbar is grayed out, and becomes available only once you have selected one or more controls.  To format using the Formatting toolbar, you first select the control that you want to format.  You can choose to make the text bold, italic, or underlined.  And you can choose for it to be left-aligned, centered, or right-aligned.  You can select a control box and then access the color palettes to

• fill the box with the chosen color

• color the text in the box

• color the outline of the box

You can change the border width of a selected control box by clicking the down-pointing arrow for the available options.  And you can add a special effect to the box including making it flat, raised, sunken, etched, shadowed, or chiseled.  You can change the font and font size of text.  You can change the form's background by selecting the label bar for the section that you want to change.  This selects the entire section.  And then you right-click the section label bar and select Fill/Back Color to select a color from the palette.  When using the AutoFormat function, you can format the entire form by clicking the form selector.  Or you can format an individual section by clicking the section selector.  Or you can format one or more controls by selecting accordingly.  To apply the AutoFormat function, you click the AutoFormat button on the toolbar.  Or you select AutoFormat from the Format menu.  You select a formatting style from the Form AutoFormats list.  To specify the attributes that you want to apply AutoFormat to, you click the Options button.  If you do not like the appearance of the finished form, you can undo the formatting by pressing Ctrl+Z.

END OF WORKING WITH FORMS

SUMMARY: You have seen how to create forms and use controls on them.  A form is a database object that contains controls that you use to enter, view, or edit data in fields. You can also use controls on forms to perform particular actions.  Forms are a useful feature for updating multiple tables at the same time. They can be created using the Form Wizard or using the AutoForm feature in Microsoft Access.  The information on forms is contained in controls. This information can be bound to a field in a source table or query, be unbound, or be calculated according to an expression. You can add bound controls to a form using the fields from the source table. Or you can create bound controls from scratch or by using control wizards.  You can modify the layout and the format properties of a form's controls. This involves repositioning and resizing control fields in the Detail area of a form, as well as using both the Page and Form Header and Footer areas in Design view. You can make changes to the format properties that apply to text in control fields such as text alignment and style, font, font size and color, and that apply to the properties of fields themselves such as background color, border size and color, and special effects.  An AutoFormat function in Microsoft Access additionally allows you to apply predefined formats to your form.

UNIT TEST:

1. Which one of the following methods is the most complex ways to create a form?

a. Creating a form from scratch

b. Using the Form Wizard

c. Using the AutoForm function

2. Which one of the following is generally used to display graphics on a form?

a. A bound control

b. An unbound control

c. A calculated control

3. Which one of the following sources can be used to provide the data in a calculated control?

a. Data from a field in a table or report

b. Data from an expression

c. Data from another control on the same form

4. Is it possible to reposition the label field and the control field for the same control independently?

a. Yes

b. No

5. Which one of the following sections does not appear by default when viewing a form in Design view?

a. The Form Header and Form Footer sections

b. The Page Header and Page Footer sections

c. The Detail section

6. Which of the following statements apply to the Autoformat feature?

a. It can be used to format individual sections on the form

b. It can be applied only to the entire form

c. There is only one standard format available

d. It can be used to format individual controls

ANSWERS:

1. a

2. b

3. b***(a)

4. Yes

5. b

6. a & d

BEGINNING EXCEL

WORKING WITH DATA 

1 OF 12 (1-4 ENTERING AND CHANGING RECORDS)

The simplest level of data management is that of entering and changing data.  The process of entering and changing data is also known as data capturing.  Because all data in an Access 2000 database is situated in tables, you enter data into a table.  You can do this using a

• Datasheet view of a table

• form

When you view a table in Datasheet view, the data in it is organized in columns and rows.  In the Datasheet view of a table you can create new records and capture the data for them.  You can also view existing records and change the data in them.  In a form you can usually view only one record at a time.  You can also design forms that display more than one record at once.  The record that you view can be presented in an attractive format that is easy to read.  Fields in the table that are automatically generated, such as a number in an ID field that serves as the primary key, can be hidden from view.  Just as with a Datasheet view of a table, you can use a form to find data in a table, and edit and enter data into a table.  In fact, forms are usually created to make these processes as intuitive and simple as possible.  You can't enter or change data in a form or table if you are working in Design view.  If you are working with a table in Design view, you click the Datasheet View button.  The view will then change and you can enter or edit data.   If you are working with a form, you can choose from a range of options by clicking the down-pointing arrow next to the View button.  To use the form to enter records, you choose the Form View option.  And then you enter your new data into the form.  You can view all the records linked to your form at once by selecting the Datasheet View option.  And you can then create new data or change existing data.
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Let's suppose that you have created an inventory control database that is used to track stock at Award Sportswear.  Award Sportswear is stocking a new range of hiking boots and you want to enter the data for it.  You also want to change some of the details for existing records in the inventory control database.  You decide that you want to enter the new records and edit existing records in Datasheet view.  To do this, you start by opening the Inventory Control1 database.  Then you click the Tables button to view the tables in the database.  To capture and edit details about products, you double-click the Products table.  The table automatically opens in Datasheet view.  To enter a new record, you click the New Record button on the Navigation toolbar.  You can also create new records by clicking the New Record button on the Access toolbar, or by simply scrolling down to the last record in the datasheet.  Then you click the Product Name field in the empty row.  And you type the name of the new product in the field.  When you start typing in the details of a new record, AutoNumber fields such as the Product ID field automatically generate a number used to track your new record.  You can move from one field to another by clicking the field you want to capture data into.  Or you can press the Tab key to move to the next field or press the Tab and Shift keys simultaneously to move to the previous record.  You can edit existing data by clicking the field you want to edit.  And then you simply type or select your new values for the field.  To copy values from one record to another, you first select the values that you want to copy.  You use the Cut or the Copy buttons, depending on whether you want to remove the original value from the record.   Then you select the field in which you want to insert the values and use the Paste button to insert them.  To view objects that have been placed on the Office clipboard during cut and copy operations, you select View - Toolbars - Clipboard.  On the Clipboard toolbar, you can view the items that have been placed on the clipboard by clicking the Items button.  And if you move your cursor over an item, a hover menu provides you with details about the item.
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Let's suppose that Heather Denfield has joined Award Sportswear as a new employee.  You need to capture her details in the Inventory Control database.  You decide to update the details of another employee at the same time, and to perform both these procedures with the use of a form.   In the switchboard for the Inventory Control database you access a form for the Employees table by clicking the Enter/View Other Information button.  And then you click the Enter/View Employees button.  To create a new record, you click the New Record button.  And you enter the details of the new employee.  You cannot enter data directly into the Employee ID field because this data is automatically generated when you capture details for your new employee.  You can click the Previous Record button until you find the record that you want to make changes to.  And then you simply edit the details in the text block that needs updating.
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Subdatasheets are an Access feature that allow you to capture information in related records from the datasheet of a table, query, or form.  For instance, in the Inventory Control database a one-to-many relationship exists between the Distributors table and the Purchase Orders table.  In Datasheet view you can use a subdatasheet from within a record in the Distributors table to edit or insert records into the Purchase Order table.  Access automatically generates subdatasheets if the Subdatasheet Name property of the table is set to Auto.  You can check this setting in Design view by selecting Properties from the View menu.  In the Table Properties dialog box the default setting for the Subdatasheet Name property is Auto.  To view subdatasheets in the Distributors table, you open the table in Datasheet view and click the plus sign in the first column of a record.  And the subdatasheet opens, displaying the fields in the Purchase Order table.  You can enter new records into the subdatasheet or you can edit existing records.  Each record in the Distributors table has its own subdatasheet containing its linked records from the Purchase Order table.  Subdatasheets can be nested, so you can view the Transactions subdatasheet of the Purchase Orders subdatasheet from within the Distributors table.

5 OF 12 (5-6 WORKING WITH RECORDS)

If a table has only a small number of records, you can quickly find a record by using the Previous Record and Next Record buttons in a form.  Or, if you view the table (or form) in Datasheet view, you may be able to locate the record at a glance.  However, tables often contain many records and more sophisticated tools are needed to locate and organize records.  If you know the record number of the record you want, you can type it into the Record text box in order to display that record.  If you don't know the record number, you can use the Find and Replace tool.  The Find and Replace dialog box lets you search a table for records containing a particular value.  Let's suppose that you are responsible for maintaining the Inventory Control database at Award Sportswear.  The company has stopped manufacturing plain T-shirts, so you want to find the record in the Products table and delete it.  To do this, you open the Products table in the Inventory Control database.  In the Products table you click anywhere in the column that contains the value you wish to search for.  Then you click the Find button.  In the Find and Replace dialog box you type the value for which you want to search.  If you click the down-pointing arrow as shown, you can specify that the search should be run against the whole table.  You can also choose how the search criteria are matched against the table or field.   You can further refine your search by clicking the More button.  You can specify a case-sensitive search by selecting this checkbox.  And you can click the Search down-pointing arrow to determine whether the search proceeds up or down from where you cursor is placed, or to run it against all records.  When you have provided your search criteria, you click the Find Next button.  In this case the first record highlighted by the search is for plain (blank) T-shirts.  So you click Cancel to close the Find and Replace dialog box.  You click the Delete Record button to delete the highlighted record.  A dialog box appears and to permanently delete the record, you click Yes.  And the record is removed from the table.  You click the Replace tab in the Find and Replace dialog box to replace the values that you search for.  You type the new value in the Replace With text box and then you click the Replace button.  Only the values that you search for change - the rest of the field and record remains the same.
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Sorting the records in a table can help you navigate.  It can help you find data with particular attributes more quickly.  You can sort data in different ways.  For instance, if you want to know which record in a table of products has the highest price, you might sort the records in terms of unit price.  When you perform a Sort operation, previous Sort operations are undone.  So products in a Products table will no longer be alphabetically arranged if you sort them according to price.  And you can't sort fields that contain Memo, Hyperlink, or OLE Object datatypes.  Suppose that you want to sort your products so that the most expensive products are displayed at the top of the datasheet.   To sort products by price, you place the cursor in the Unit Price column.  And you click the Sort Descending button.  The products are now arranged from those with the highest price to those with the lowest.  To arrange the products with those that cost the least at the top of the table, you click the Sort Ascending button.  When you sort records, the record number of each record changes to reflect the new ordering of records.  The fields in each record, including the primary key field, in this case Product ID, remain the same.  You can also sort records alphabetically according to a particular column.  So if you want to arrange products by name in ascending alphabetical order, you click the Sort Ascending button.  If you're looking for a product with a particular name, it will be easier to find it if the records are sorted alphabetically.  A filter creates a temporary view of a table in which only records with certain values are displayed.  For information on creating more advanced filters, see the SmartCourse "Microsoft Office 2000: Advanced Access".  For instance, you can apply a filter to a table of products by selecting a record where the unit price is $20 and clicking the Filter by Selection button.  Only records where the unit price is $20 are now shown in the table - and they are still sorted alphabetically by their names.  To remove the filter, you simply click the Remove Filter button. 

7 OF 12 (7-10 CREATING AND MODIFYING QUERIES)

A relational database lets you run queries to analyze data and generate reports.  A select query is similar to a filter or a Find operation in that it searches for records according to specified criteria.  Like a Sort operation, you can organize the results of your select query - called a resultset - in different ways.  Queries differ from filters and Sort operations in that they can be run against several tables.  You use the relationships between tables to construct queries with resultsets containing records from several tables.  Let's say that you have created a table for employees and a table for sales and that there is a one-to-many relationship between the tables.  A field called Employee ID is the primary key in the Employees table and is a foreign key in the Sales table.  And let's say that one of the records in the Employees table is for an employee named Tonya Chavis.  You can construct a select query that yields a resultset with the following fields and data:

• an employee name field   containing "Tonya"

• a sales date and time field   containing the date and time of   each of Tonya's sales

• a sales value field containing   the monetary value of the goods   sold in each sales transaction

Queries can be saved as database objects so that you don't have to re-create the same query repeatedly.  You can choose between using a wizard to create queries and creating them in Design view.  Like other database objects, you can modify queries by opening them in Design view.
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Let's suppose that you are the sales manager at Award Sportswear and are responsible for monitoring the performance of the sales team.  You want to use the Query Wizard to construct a select query that will allow you to view each member of the sales team's client base, using the Customers database.  You start by opening the database.  And you select Queries from the Objects toolbar of the Customers database.  You click the New button.  And in the New Query dialog box you select the Simple Query Wizard option and click OK.  To include a field in your query, you select it and click the Add Field button.  You click the Tables/Queries down-pointing arrow.  You select the Employees table from the Tables/Queries drop-down list.  Then you select the fields from the Employees table you want to include in your query and you click Next.  You can type a name for your query in the text box.  And you can choose to either open the query or modify its design in Design view.  To view Help on working with the query, you select the checkbox shown and you click Finish.  Once the query has executed, the resultset is displayed in a Datasheet view.  You can perform Find, Sort, and Filter operations on the resultset.  You click the Exit button to close the Query window.  And you can see that your query is now listed as a Queries object.
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Let's suppose that you want to create a more complex query of the Customers database using the Design view.  You want your query to show the products bought by customers as well as who sold the products.  You start by double-clicking the Create query in Design view icon.  Design view opens with the Show Table dialog box, which allows you to select tables and queries on which to base your query.  You then select the Customers table.  And you click Add to include it in your query.  When you have done this for each table that you want to include, you click Close.  You can rearrange the tables in the top portion of the screen so that the relationships between them can be seen clearly.  A single product can be bought by many different customers and each customer can buy many different products.  So the Customer/Product junction table exists to create a many-to-many join between the Customers table and the Products table.  In the lower portion of the screen you construct your query by specifying

• the fields to include

• how to sort the records

• whether the field should   be displayed in the resultset

• which filters to apply

You start by clicking the Table row in the first column and selecting a table - in this case the Employees table - from the drop-down list.  And you select a field - in this example the LastName field - from the list of fields in the Employees table.  You decide to sort the field in Ascending order.  So that you can view the customers linked to each employee, in the next column of the query design window you specify the Customers table.  And you choose the CompanyName field, sorting it in Ascending order.  The one-to-many relationship between the Employees table and the Customers table is automatically built into your query.  To relate products to customers, you use the Customer/Product Junction table and select the ProductID field.  The many-to-many relationship ensures that a record will be generated for each different product bought by each different customer.  So that you can identify the products bought by each customer by name rather than just by a number, you select the ProductName field from the Products table.  And you don't need to view the Product ID in the resultset of your query, so you deselect the checkbox for showing the Product ID field.  To execute the query, you click the Run button.   The Query resultset is displayed as a datasheet.  Notice that the Sort operations that you included for each field are applied from left to right.  So the Employees records are sorted before the Customers records, which are sorted before the Products records.
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You can include a calculated field in a query to find out the effects of changing data in a field.  And you can use a utility called the Expression Builder to help you with the syntax in expressions used to specify calculated fields.  Let's say that you have used the Simple Query Wizard to create a query of the Products table.   You have opened the query in Design view and you now want to create a calculated field to view the effects of a 5 percent increase in unit prices for all products.  To do this, you click the first empty cell in the Field row of the Query Design grid.  And you type the name of the Unit price field in brackets.  You indicate that you want to multiply the values in this field by typing *.  And then you type the amount by which you want to multiply the values - in this case 1.05.  When you place your cursor elsewhere, Access automatically names the first calculated field Expr1.  You can rename the calculated field by typing in a more descriptive name.  You click the Run button to view the results of your query.  If you change a value in the resultset, the record in the calculated field is automatically updated.  You now want to view the records in the calculated field in currency format, so you return to Design view.  Then you select the field and click the Properties button.  In the Field Properties dialog box you select Currency from the Format drop-down list and you exit the dialog box.  Then you click the Run button.  The values in the Up5% field are now displayed as currency.  To use the Expression builder, you right-click the field in which you intend to create an expression.  And you select the Build option.  This list box of the Expression Builder shows the different categories of elements you can include in your expression.  The middle list box shows the available fields in the current query, which is the category opened by default.  In the third list box you can sometimes select values for categories in the middle box to include in your expression.  You can select from a range of functions to include in your expression.

11 OF 12 (11-12 PRINTING RECORDS)

Because information cannot always be communicated electronically, it's often useful to have a printout of database records.  You can print records directly from a datasheet that has been generated from either a table, query, or form.  Or you can print data in a form to improve the appearance of your printout.  When you print a form, the records linked to the form print in the same layout as the form.  This is particularly useful when each record in a form spans multiple pages when you preview them in Datasheet view.  You can use Find operations in a table or form to select particular records that you want printed.  And you can print records that have been filtered.  And if you want the information in a table or form to appear in a particular order, you can apply Sort operations.  To preview the appearance of a table's printout, you select the table and click the Print Preview button.  You can change the magnification of the display by clicking the Zoom down-pointing arrow and selecting an option, or typing in your own specification.  You can use the arrow buttons to flip between pages in the Print Preview window.  And you can use the scroll bars to navigate each page in the Print Preview window.  You click this button to preview two pages at once.  In this case you can see each record will be printed across two pages.  You can preview a range of pages by clicking this button and clicking and dragging to select pages to preview.  You print the table by clicking the Print button.  And you click the Close button to close the Print Preview window.  In Datasheet view you can select a particular record by clicking the Record Selector.  And if you hold down your Shift key, you can select a range of records.  To print the selected records, you choose the Print option from the File menu.  If you click the Print button, the entire table will automatically print.  In the Print dialog box you select the Selected Record(s) radio button to print only the records you have chosen and you click OK.  Sometimes, you might want printouts that reflect the relationships in your database, rather than the content of your database.  To create a printout of  relationships in an Access database, you first click the Relationships button to view relationships.  If you're interested only in viewing particular relationships, you can right-click the tables that are not relevant and choose the Hide Table option.  You can repeat this until you're left with the relationships that you want to print.  To print the relationships, you select Print Relationships from the File menu.  The Print Preview window automatically opens and you click the Print button.
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Let's suppose that you are the Sales Manager at Award Sportswear and you want a printout of all the customers from the city of Boston.  You have opened a database called Customers.  You start by opening the Customers table in Datasheet view.  To view the records for only Boston, you click in one of the fields in the City column that contains the value Boston.  Then you click the Filter by Selection button.  To see a preview of how the table will appear when printed out, you click the Print Preview button.  In the Print Preview window you click the Two Pages button so that you can view all the fields in each record.  You click the down-pointing arrow and select 75% from the drop-down list box to increase the magnification.  And then you use the scroll bar to view each field in the record.  You decide to print from a form so that you can view all the fields of each record on a single page.  So you click the Close button.  And you minimize the Customers table.  You select the Forms option on the Objects toolbar and double-click the Customers form.  To perform a search for records of customers in Boston, you click the Find button.  In the Find and Replace dialog box you click the Find Next button once you have specified the criteria for your search.  Then you click the Cancel button to close the Find and Replace dialog box.  So that only records for Boston are displayed, you click the Filter by Selection button.  To view a preview of your printout from the Customers form, you click the Print Preview button.  And to print the records, you select the Print option from the File menu.  In the Print dialog box you can choose a range of pages to print.  And you send a printer document based on the form to the printer by clicking OK.

END OF WORKING WITH DATA

SUMMARY: You have seen how to work with data using Microsoft Access.  You can enter records directly into a table by opening it as a datasheet. You can also use forms that have been customized to simplify the process of entering data.  Cutting or copying records from one field to another can save you time when creating new records. You can place multiple items on the Office clipboard during these operations and view details about each item that you have placed on the clipboard.  Microsoft Access contains a variety of tools that you can use to find and sort records when working with a table containing large amounts of data.  The Find and Replace tool allows you to search a table for records containing a specified value in a particular column. You can also use it to replace a specified value with a new value.  Sorting records in a table alphabetically or numerically can help you find particular information. You can use any column in a table to sort the records. You can use a filter to view particular records within a table.   You can use a relational database to view related records from different tables. This is done by creating a select query. When you run a query against one or more tables, the results can be viewed as a datasheet and are known as a resultset.  You can filter the results of your query by specifying criteria for the resultset when you build the query. This allows you to construct queries that retrieve only records containing the values that you specify.  You can also perform calculations with and on numeric fields in your query and display the results in a calculated field. For instance, you can multiply the values in different fields of a record by each other and display the result in a calculated field. Or you can multiply the values in a field by a constant of your choice.    You can print records from a table or you can print the records that are linked to a form. A print preview window allows you to preview the appearance of the printed pages.  You can apply filter operations to a table and form if you want to print only particular records. Or you can select the records that you want to print from a datasheet and print only the selected records. 

UNIT TEST:

1. In which of the following views of database objects can you enter new records?

a. The Design view of a table

b. The Datasheet view of a form

c. A Form

d. The Datasheet view of a table

2. Which key would you normally press to move to the next field in a form?

a. The Shift key

b. The Alt key

c. The Tab key

d. The Spacebar

3. Can you use the Office Clipboard when working with data in a form?

a. Yes

b. No

4. Which of the following statements describe the Find and Replace tool?

a. You can search for values in a particular column

b. You can search for values in an entire table

c. You can specify values for multiple fields in a Find operation

d. You can update records by using the Find and Replace tool

5. Which of the following options describes how Sort operations are applied with the Sort buttons?

a. You can sort records in numeric order

b. You can apply Sort operations to multiple fields simultaneously

c. You can sort records in alphabetical order

d. The only attribute of a record that changes during a Sort operation is the record number

6. Which of the following statements describe select queries?

a. A select query can retrieve records from multiple tables

b. A select query can link records from unrelated tables

c. A select query is the most common type of query

d. You can use a select query to sort records

7. Which of the following options describe calculated fields?

a. They should be included in tables rather than in queries

b. They can be used to view the effects of a constant change to numeric data in a field

c. Records in a calculated field update automatically if you change data in fields upon which records in the calculated fields are based

d. You cannot apply formatting to a calculated field

8. Which of the following Access wizards can be used to create calculated fields?

a. The Expression Builder

b. The Create Query wizard

c. The Create Table wizard

d. The Create Form wizard

9. Which of the following options could you use to sort the order in which records appear in a printout?

a. The Filter by Selection tool

b. The Find and Replace tool

c. The Filter by Form tool

d. The Sort Ascending tool

e. The Sort Descending tool

ANSWERS:

1. b, c & d

2. c

3. Yes

4. a, b & d

5. a, c & d***(bd)

6. a, c & d***(bc)

7. b & c***(ac)

8. a***(b)

9. d & e***(ac)

END OF BEGINNING ACCESS

